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Support 

You can visit the HP Software Support web site at: 

www.hp.com/go/hpsoftwaresupport 

HP Software online support provides an efficient way to access interactive technical support tools. As a 
valued support customer, you can benefit by using the support site to: 

 Search for knowledge documents of interest 

 Submit and track support cases and enhancement requests 

 Download software patches 

 Manage support contracts 

 Look up HP support contacts 

 Review information about available services 

 Enter into discussions with other software customers 

 Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require 
an active support contract. To find more information about support access levels, go to the following URL: 

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to the following URL: 

http://h20229.www2.hp.com/passport-registration.html



HP Discovery and Dependency Mapping 
Inventory 

Release Notes 
Software version: 7.60 / August 2009 

This document provides an overview of the changes made to Discovery and Dependency Mapping Inventory 
(DDM Inventory) for version 7.60. It contains important information not included in the manuals or in the 
online help. 
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 Application Recognition 

— Express Teaching 

— Package-based Teaching 

— Software Inventory Reports 

— UNIX Operating System Versions 

 Support for Devices Infrequently Connected or on VPN or DHCP 

 Scanner Enhancements 

— Support for Prelinked ELF Files on Linux Systems 

— Support for Virtualization HP-UX vPar and IBM AIX LPAR 

 New Device Types 

 Digital Signatures 

Compatibility Notes 

Scanner Support Information 

Obsolete Features 

Documentation Updates 

Installation Notes 

Enhancements and Fixes 

Known Problems, Limitations, and Workarounds 
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Conventions Used in this Document  
By default, when you install the DDM Inventory Server software, all the components will be in one of the 
locations specified in the following table. The placeholders are used to represent the DDM Inventory 
program and data folders referenced in this document: 

Folder Placeholder Platform Default Location 

Windows  
Server 2008 x64 

C:\Program Files (x86)\Hewlett-
Packard\DDMI\7.60 

Program 
Files 

<InstallDir> 

All others C:\Program Files\Hewlett-Packard\DDMI\7.60 

Windows  
Server 2008 

C:\ProgramData\Hewlett-Packard\DDMI Data 
Files 

<DataDir> 

Windows Server 
2003 

C:\Documents and Settings\All 
Users\Application Data\Hewlett-Packard\DDMI 

You can customize both of these locations when you install the DDM Inventory Server. 
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In This Version 

Introduction 

These release notes are for DDM Inventory 7.60. This new version of the product is the upgrade path for 
users of DDM Inventory 7.5x and Enterprise Discovery 2.5x.  

If you want to see what features have been introduced in previous versions of DDM Inventory (formerly 
called Enterprise Discovery), you can read the Release Notes for those versions available on your installation 
CD under bin\documentation.  

License Schema 

Each DDM Inventory server can collect data from a maximum of 50,000 inventoried devices and 60,000 
discovered devices in total. The port limit is 150,000 ports (whichever comes first). A DDM Inventory 
Aggregator can support 50 servers and up to 500,000 devices. 

Updated Third-Party Components  

 Java Runtime Environment (JRE) 1.6.0_u13 
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New Features  
New features have been introduced in this version of DDM Inventory that offer powerful advantages to the 
existing functionality. In addition to general product enhancements, this release offers significant additional 
capabilities in the areas of software inventory and application teaching (used in the recognition process) and 
support for mobile and infrequently connected devices such as field sales force notebooks.  They are outlined 
in the following sections.  

Application Recognition  

Express Teaching  

This release introduces a new web-based Express Teaching Tool. It provides a simplified interface for adding 
Windows software to the Software Application Index (SAI). It enables you to normalize the presentation of 
discovered software components into Recognized Applications – that is, teach unrecognized files. The 
Express Teaching Tool simplifies the task of teaching files, improves application recognition coverage, and 
saves you time.  

 
The SAI Editor and Analysis Workbench need to be used for teaching complex applications. 

Before using Express Teaching, you must configure an SAI to store the results.  See Administration > 
System Configuration > Scan Processing. 

For more information, refer to “Application Teaching” in the Scan Data Analysis Guide. 

Package-based Teaching 

DDM Inventory collects and displays information about installed packages, including RPM, Depot, BFF, 
MSI, and Pkg formats, as well as the relationships between these packages and files that belong to them. 
You can use this information to teach new applications or new versions of existing applications.  

 Scanners can now collect information about which files (found as part of the software inventory) belong 
to which installed packages. To enable it, the Scanner Generator has two new options: a Hardware Data 
option (Packaged File Data) that you can use to enable or disable collection of file/installed package 
relationship information, and a Software Details option (Packaged File Data) that specifies whether 
directories of where packages were installed should be scanned.  

 A new column in the Viewer displays the package name and version as part of the directory and file 
data. The Viewer also has a new “Go to Installed Package” local menu item.  

 The SAI Editor has the ability to create new installed package rules to recognize applications packaged 
in a standard package file format, avoiding the need to teach application files to the SAI. 

 The SAI Editor now provides a Package column when you import information from recognition results. 
By sorting on this column, you can group all files belonging to a particular package together, even 
though they may be located in different directories scattered throughout the file system. You can then 
easily teach all files belonging to a particular package. This is useful for applications that can be 
supplied both in packaged as well as unpackaged installation format. 

Collecting the package information and creating rules based on it allows DDM Inventory to automatically 
recognize newer versions of applications. 

For more information, refer to “Application Teaching” in the Scan Data Analysis Guide. 
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Software Inventory Reports  

The Reports have been re-organized to help you quickly find all software discovered on a device. The new 
Software Inventory Reports group includes three types of reports, each with drill-down capability: 

 The Recognized Applications reports provide details about software applications detected on your 
scanned devices that are currently included in the DDM Inventory SAI. This includes information about 
licenses and utilization. 

 The OS Reported Applications reports provide information about software applications and features that 
were reported by the operating system on each scanned device. These applications may or may not be 
included in the Recognized Applications. 

 The Unrecognized Files reports list the files on your scanned devices that were not recognized as 
belonging to a known application. 

Note that the Recognized Applications (formerly called Applications) and Unrecognized Files reports were 
previously included in the Scanned Device Reports group.  

For more information, refer to “Using the Reports” in the Network Data Analysis Guide. 

UNIX Operating System Versions  

It has always been challenging to recognize UNIX operating system versions based on installed files alone. 
DDM Inventory Scanners can now identify the operating system and report its version reliably using two 
hardware fields in their scan files. This method of determination achieves much improved recognition of 
UNIX operating system versions. 

For more information, refer to “Application Recognition” in the Scan Data Analysis Guide. 

Support for Devices Infrequently Connected or on VPN or DHCP  

DDM Inventory will now work more consistently with devices that make infrequent and short connections to 
the network. The new “Call Home” option allows these devices to be discovered and scanned on a regular 
basis. This is of particular advantage for networks that have VPN clients or very short DHCP lease time. 
With the Call Home capability, the client device will contact the DDM Inventory server the first time it 
connects to the corporate network or if no activity has occurred within a defined time interval after it has 
connected.  

The Call Home option is enabled by default. This option comes into play in the following scenarios: 

 Devices that have not connected within a defined interval. The inventory information for these devices is 
most probably out of date. The Agent will call the DDM Inventory Server to notify it that the device is on 
the network and needs to be scanned. 

 Devices that have never connected but have the Agent installed as part of the corporate image. The 
Agent will call the DDM Inventory Server. This action provides immediate initial discovery of new 
devices that have just connected to the network. The new devices will be processed at a higher priority 
by the DDM Inventory Server, thus minimizing the period of time for which you have no inventory 
information about the new devices. 

In addition to the Call Home feature, DDMI now has the following additional capabilities: 

 A priority queue for requesting inventory updates from the devices that use the Call Home function 

 The ability to retrieve the existing scan file on the device (if it is more current than the one in the DDM 
Inventory database) before the Server initiates the next scan. This option is disabled by default but can 
be enabled in Administration > System Configuration > Scanner Deployment. 
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As users on your network become increasingly mobile, Call Home enables all of your devices to be discovered 
and inventoried in a timely manner. 

For more information, refer to “Setting Up Agents and Scanners” in the Installation and Initial Setup Guide. 

Scanner Enhancements 

Support for Prelinked ELF Files on Linux Systems  

The new ELF Prelinking Aware Scanner option provides for better file recognition on Linux systems. It 
instructs the Scanner to determine whether an executable file has been prelinked by the ELF Prelinking 
Utility (prelink). If this option is enabled, the Scanner will calculate the size and signature of the file before 
it was prelinked. This is useful for accurate application recognition, because the file size and signature are 
used to perform application matching. However, enabling this option produces extra overhead during the 
scan, as the Scanner needs to run the prelink utility to obtain the original executable file. 

For more information, refer to the “Scanner Generator” chapter in the Configuration and Customization 
Guide. 

Support for Virtualization HP-UX vPar and IBM AIX LPAR  

Scanners now capture virtualization related attributes from HP-UX Virtual Partitioning (vPar) and IBM 
AIX Logical Partitioning (LPAR). These hardware attributes provide comprehensive information about the 
relationships and resources used by virtual machines.  This information is populated in the 
hwOSContainerProperties table in the Reporting database. 

For more information, refer to the “Virtualization in DDM Inventory” chapter in the Reference Guide. 

New Device Types  

DDM Inventory can now successfully identify several new device types. The following table shows the new 
devices and the icons that represent them: 
 

Icon Device  Icon Device 

 
Windows 7 Server  

 
Windows Thin Client 

 
Windows 7 Workstation  

 
Windows CE Thin Client 

 
Linux Thin Client  

 
Windows XP Embedded Thin Client 

 
For a comprehensive list of device types, refer to Help > Classifications > Device Types in the DDM 
Inventory Web UI. 

 9 



Digital Signatures 

Files that are built by HP and shipped as part of DDM Inventory are digitally signed by the Hewlett-
Packard Corporation.  The following file types are covered: *.msi (except Win32 agent MSI), *.exe, *.dll, 
*.sys, *.jar and *.war. 
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Compatibility Notes  

Reports Database Changes 

Deletions 

 The File_ApplicationName column in the File table has been deleted. Use the File_Description 
column instead. 

 The Aggregate.Appliance.Appliance_ProxyConfig column in the Appliance table has been 
deleted, since the proxy management facility has been removed. 

Additions 

 The hwOSContainerProperties table has been added. 

 The hwOSInstalledAppNormalizedPublisher, hwOSInstalledAppProductCode, and 
hwOSInstalledAppPackageType columns have been added to the hwOSInstalledApps table. 

 The hwOSContainerType column has been added to the hwOSContainers table. 

 The Version_Description column has been added to the Version table. 

 The hwOSWMISoftwareFeatureNormalizedVendor column has been added to the 
hwOSWMISoftwareFeatures table. 

 The File_NormalizedPublisher column has been added to the File table. 

 The Device_AgentSSHPublicKeyStatus, Device_AgentWorkflowType, and 
Device_AgentAUMUpgradeState columns have been added to the Device table. 

 The hwOSInstalledAppNormalizedPublisher, hwOSInstalledAppProductCode, and 
hwOSInstalledAppPackageType columns have been added to the hwOSInstalledApps table.  

 The hwOSWMISoftwareFeatureNormalizedVendor column has been added to the 
hwOSWMISoftwareFeatures table. 

Modifications 

 The Directory.Directory_Path column in the Directory table has been increased in size from 255 
to 1024 characters. 

 The Application, ApplicationCategory, Company, Language, OperatingSystemGroup, Release, 
and Version tables are now populated with the full contents of all the loaded SAIs rather than just 
those which are actually found on inventoried devices. 
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Scanner Support Information  
All Scanners and Agents supported in the 7.5x releases of this product are supported in the 7.60 release. 
Refer to the Compatibility Matrix for the 7.5x release of interest for the list of all supported platforms. 

 
If you upgrade from a previous release, it is possible to use the Scanners and Agents from 
previous releases if you explicitly specify the Scanner and Agent versions using the configuration 
options on the following pages: 
Administration > System Configuration > Scanner deployment 
Administration > System Configuration > Agent communication 
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Obsolete Features  

Health Panel 

The footer panel that contains the server clock has been removed because most of its content has been 
deprecated. The server clock can now be found in the Connection Info panel. See the Connection Info 
command in the File menu. 

Enterprise Mobility Suite 

DDM Inventory no longer supports the integration of the Enterprise Mobility Suite (EMS) server to collect, 
store, and display information about mobile devices. 

Client Install 

The installation of the client tools is no longer supported on Windows Server 2000. You must use Windows 
XP/Vista or Windows Server 2003/2008. 

Event Notification Delay 

Event notification delays have been removed. All events filters in Administration > Event Filter 
Configuration will have their delay configuration removed and will now operate without notification delays. 

Alarms License 

This release contains legacy code and capabilities known as “Alarms” functionality. This code is provided in 
support of existing customers who acquired a license for this part of the product prior to HP’s purchase of 
Peregrine Systems and is not available to any new customers. This functionality continues to exist “as is” 
and is no longer being maintained by the DDM Inventory product organization. 
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Documentation Updates 
The first page of this release notes document contains the following identifying information: 

 Version number, which indicates the software version.  

 Publish date, which changes each time the document is updated.  

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to:  

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page. 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details. 

NOTE: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 
download Adobe Acrobat Reader, go to the following web site: 
http://www.adobe.com/ 

The following PDF documents are available in the DDM Inventory Web UI: 

 Planning Guide  

 Installation and Initial Setup Guide 

 Configuration and Customization Guide 

 Network Data Analysis Guide 

 Scan Data Analysis Guide 

 Reference Guide 

14 

http://h20230.www2.hp.com/selfsolve/manuals
http://h20229.www2.hp.com/passport-registration.html


Installation Notes 
Instructions for installing DDM Inventory are documented in the Installation and Initial Setup Guide 
provided in Adobe Acrobat (.pdf) format.  

 Perl, MySQL, Tomcat and Apache are standard parts of the DDM Inventory, included with each 
server installation. If you have these components installed already, make sure to remove them 
before installing DDM Inventory. You may NOT substitute any other technologies in place of the 
standard installation. 

Software and Hardware Requirements  

The following sections detail the requirements for the DDM Inventory server and client components, 
respectively. 

Client Requirements 

The DDM Inventory client components (Analysis Workbench, SAI Editor, SAI Update Wizard, System 
Panel, and Viewer) have the following requirements: 

Resource Requirement 

Operating System Windows XP/Vista, Windows Server 2003/2008 

CPU Pentium® III, 500 MHz 

RAM 500 MB (1-3 GB if you will be analyzing a large number of scan files) 

Disk 100MB required (2GB recommended) 

Java™ Runtime 
Environment 

See Help > Compatibility Matrix in the DDM Inventory GUI for 
versioning information 

Server Requirements 

The DDM Inventory Server can be installed on 32-bit versions of Windows Server 2003 (SP1, SP2, or R2) or 
Windows Server 2008 (SP1) or the 64-bit version of Windows Server 2008 (SP1 or SP2). Refer to the 
Compatibility Matrix for information about all supported platforms. 

Recommended Server Platforms 

For large servers (up to 50,000 devices), the following is recommended: 

 HP Proliant Model: DL380 G5 (Performance)  

 CPU: 2 x Quad Core (Intel® Xeon® 5400 series)  

 Memory: 8 GB 

 Disk: See the Storage Requirements section below. 

For medium servers (up to 15,000 devices), the following is recommended: 

 HP Proliant Model:  DL360 G5 (Performance) 
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 CPU: 1 x Quad Core(Intel® Xeon® 5400 series) 

 Memory: 6 GB 

 Disk: See the Storage Requirements section below. 

Sample Server Scenarios 

The following table details a variety of scenarios that can help you estimate your server hardware 
requirements. The Disk value is for your data directory. You will require at least 6GB for the DDM 
Inventory installation. 

The information presented below is for illustration purposes only.  Proper sizing of the DDM Inventory 
server(s) may require the assistance from a qualified architect.  HP recommends utilizing experienced 
resources to assist in architecture and the initial deployment of DDM Inventory.  Among the factors that 
need to be considered and which will impact the infrastructure architecture are the following: 

 Number of and distribution of devices (such as if slow WAN links exist between large population groups) 

 Type of and amount of information collected (examples below demonstrate the impact software 
utilization will have on overall system capacity) 

 Frequency of scans (the example below assumes a bi-weekly scan interval, more frequent scanning may 
require additional server capacity) 

 Amount of data collected (the examples below assume an average scan file size of ~250KB, which is 
representative of an average PC (large servers may generate considerably more data and therefore 
require additional capacity to process the data) 

 Environmental factors, such as integrations with other products, network characteristics, and 
operational requirements may impact the architecture of the DDM Inventory solution 

 The number of XML Enrichers that are running on the server 

 The settings in the virus checker installed on the server. Virus checking can add significant overhead. 

Table 1 – Suggested Hardware Requirements 

Discovered 
Devices 

Inventoried 
Devices Ports A

gg
re

ga
ti

on
 

A
u

to
m
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ed

 
In

ve
n

to
ry

 

T
op

ol
og

y 

Memory 
(GB) CPU* 

Disk 
(GB) 

6,000 5,000 36,000 
 

x  1.5 
1 CPU 
2.4 GHz 25 

6,000 5,000 36,000 
 

x x   3** 
1 CPU  
2.8 GHz 40 

  18,000 15,000 108,000 
 

x  
   2 

2 CPUs or cores 
3.0 GHz 70 

18,000 15,000 108,000 
 

x x 5 
2 CPUs or cores 
3.0 GHz 105 

60,000 50,000 150,000 
 

x  4 
2+ CPUs or cores 
3.6 GHz 200 

60,000 50,000 150,000  x x 7 2+ CPUs or cores 260 
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Discovered 
Devices 

Inventoried 
Devices Ports A

gg
re

ga
ti

on
 

A
u

to
m

at
ed

 
In

ve
n

to
ry

 

T
op

ol
og

y 

Memory 
(GB) CPU* 

Disk 
(GB) 

3.6 GHz 

50,000 50,000 n/a x n/a n/a 2 
2 CPUs or cores 
3.0 GHz 10 

500,000 500,000 n/a x n/a n/a 3 
2 CPUs or cores 
3.6 GHz 50 

 CPU processor speeds are approximate guidelines. Newer CPUs may have lower frequencies but higher 
performance than those shown in the table. HP DDM Inventory consists of multiple processes, many of 
which are also multi-threaded. As a result, it benefits from Simultaneous Multi-Threading (SMT) 
technologies such as Intel® Hyper-Threading and Multi-core. 

** This is for 5 map sessions. If you want to use more than 5 map sessions, you will require more memory. 

These calculations have been tested as scenarios for maximum disk size on the server.  

For the Inventory license, this includes: 

 “Backup Scan Files” is enabled (on average, each scan file is 250KB) 

 “Delta scanning” is enabled 

 Space required for two backups (one stored backup, and one “in process” backup) 

For the Network Topology license, this includes: 

 “Statistic Export” is enabled (CSV files) 

 200 users, with each user account saving 10 map configurations files 

 Space required for two backups (one stored backup, and one “in process” backup) 

Storage Requirements  

DDM Inventory is a highly I/O intensive application. High I/O performance of the disks where the data 
resides is crucial to the correct operation of DDM Inventory. Disks need to reside local to the DDM Inventory 
server or on a high performance SAN.  Network drives and clusters are not supported. Some customers have 
reported problems with SAN environments so they are not recommended.    

Benchmark your disk I/O performance prior to installing DDM Inventory for management of any large 
environment. For a medium to large DDM Inventory server deployment, minimum recommended 
throughput (as benchmarked on an idle system when the DDMI Inventory server is not running) is  
70 MB/sec for read accesses and 40MB/sec for write accesses. 

Your disk space requirements may differ depending on how you are using DDM Inventory. 

 For performance reasons, the disk where DDM Inventory data is stored should have at least 4K 
clusters. 

For the average size of scan files, refer to the “Disk Space Considerations” chapter in Installation and Initial 
Setup Guide. The inventory data collected in the scan file is stored in compressed format. For processing, it 
gets extracted and populated into the database. In addition, if delta scanning is enabled, DDM Inventory 
keeps a copy of the original scan file as well as the enriched copy. Because of these extra disk space 
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requirements, we recommend that you budget at least 5 times as much disk space for each device being 
scanned. 

 If your average scan file size is large, adjust your disk space requirements accordingly. 

Recommended Fault Tolerance Configurations 

The recommended fault tolerance configurations are the following: 

 Raid 1 

 Raid 1+0 

DDM Inventory must be installed on a local disk. It cannot be installed on network drives, SAN drives, or 
clustered devices. DDM Inventory has been tested and can be successfully installed in a RAID (redundant 
array of independent drives) level 0 and level 1 environment.   

RAID level 0 uses a striped disk array strategy that does not provide fault tolerance. Data striping spreads 
out blocks of each file across multiple disk drives. In our test environment we use 2 drives. This 
configuration does not provide for redundancy. It improves performance but does not deliver fault tolerance. 
If one drive fails then all data in the array is lost. 

RAID level 1 uses a mirrored set strategy that provides fault tolerance from disk errors and single disk 
failure. It results in increased read performance with very small performance degradation when writing. The 
array continues to operate as long as at least one drive is functioning.  

Because it offers the best tradeoff of performance and reliability, level 1 is the recommended RAID platform 
for DDM Inventory. For large networks, level 0 can also be used if performance is more important than fault 
tolerance. RAID level 5 is not supported. 

Upgrading from Earlier Releases 

For information about upgrading from earlier releases of DDM Inventory refer to the “Upgrade and 
Migration Scenarios” chapter in the Installation and Initial Setup Guide. 
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Enhancements and Fixes 
The following items were added or fixed in the current software release. Table 2 lists enhancements to 
existing features or behavior. Table 3 lists problems that were fixed (identified by error tracking number). 

Table 2 - Enhancements 

Location Description 

Administration > 
System 
Configuration > 
Recognition file data 

This page has been removed since it contained only one option setting (Import File 
Data). This option has been moved to Administration > System Configuration > 
Scan processing page for better organization. 

Agentless Scanning The size of binaries used to perform agentless scans on Windows systems has been 
reduced. 

Aggregate Status > 
Aggregate Server 
Health 

The display is now more readable as a result of combining the Name and IP 
columns into a single column. 

Device Manager > 
Update Model Panel 

Administration > 
Data Management > 
Update device 
models 

There is now an option to reset SSH public keys. 

Documentation The “Agent Deployment” section in the “How DDM Inventory Works” chapter in 
the Reference Guide has been renamed and enhanced to better explain Agent 
security. 

Documentation Application teaching content was re-organized and expanded for improved 
usability. 

Inventory A new exception has been created for devices that no longer have an IP address in 
the DDM Inventory database. 

MIB Browser You can now use the option-click on the Type column (that is, click the Option key 
while clicking the column header) to sort it alphabetically. 

Online Help A link was added to the on-line help from the Help navigation tree. 

Reports When exporting report data to comma separated values (CVS), even if the query 
times out, the query will continue to run and the export data is available 
immediately. Also, the local and aggregate Inventory report has been added to the 
list or reports to run overnight. 
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Location Description 

Reports In the Detail Reports section of Reports > Scanned Devices, additional menu 
items are now available: 

 The Inventory of Scanned Devices (Hardware) report displays device 
hardware data. 

 The Inventory of Scanned Devices (Application Columns) report displays 
device application data. 

The title of the previous Inventory of Scanned Devices report has been renamed 
Inventory of Scanned Devices (All Columns). Links have been added to each report 
to enable you to switch to any of the alternate Scanned Device views. 

Reports A new VMware inventory report is now available that lists only VM host devices. 
To view a list of the individual VMs hosted by a particular device, click the VM 
Count column for that device. 

Reports The Find functionality in the report request module has been enhanced to allow 
for greater flexibility in queries and better usability. It has been added to the 
report request module wherever it makes sense to have it. 

Reports The sort direction in reports is now displayed. 

Reports CSV export initiated by clicking on the [Export] link in most reports, now runs 
significantly faster. Also, if the CNode_LabelMAC column is present in the list of 
exported fields, it will now have a space inserted after the first 6 characters to 
improve legibility and to ensure that spreadsheet programs do not interpret it as a 
number. 

Scanner (Windows) The following enhancements were made to the Windows Scanner: 

 The Windows Scanner now collects the real content of the System32 directory 
on 64-bit Windows platforms.  Previously System32 and SysWow64 directories 
were identical and contained details of 32-bit executables because of the file 
system redirection for Win32 applications. 

 Leading and trailing spaces are now stripped from version data fields collected 
from Windows executable files. 

 The hwOSInstalledAppProductID hardware field is now populated for 
applications packages in the MSI format whenever it is available. The new 
hwOSInstalledAppProductCode hardware field stores the MSI’s product 
GUID. 

Scanner Generator The “Installed Applications” checkbox has been renamed to “OS Registered 
Applications” and the “Installed Applications (WMI)” checkbox has been renamed 
“WMI Software Features” for greater clarity. 

Scanner Generator All dialogs now have access to online help. 

Server When the DDM Inventory Server processes the scan file from a device and 
discovers that the preferred IP address reported in the scan file is different from 
the one currently used for SNMP modeling, the Server may re-run SNMP 
modeling process on the new address to keep information in the database up-to-
date. 
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Location Description 

Server Performance has been improved and memory usage requirements are reduced 
during DDM Inventory Discovery Engine startup.  

Solaris SPARC 
Scanner 

Core/logical CPU detection now occurs on UltraSPARC CPUs using the 
CoolThreads technology. 

System Panel Hardware panel content is updated upon request (for example, a request to detect 
up-to-date available disk space). 

 

Table 3 - Problems Fixed 

Number Location Description 

QCCR1C186 Administration > 
Account 
Administration 

The “Web access” option is now disabled when adding 
Aggregator/Scanner type accounts. 

QCCR1C4457 Applets There is no longer any need to restart all browser sessions 
when users change their DDM Inventory passwords. 

QCCR1C18753 Administration > 
Discovery 
Configuration 

Tabs are now remembered even after the Refresh button is 
clicked. 

QCCR1C18831 Server Before running the daily backup, tables are checked. If 
needed, a repair is attempted. 

QCCR1C18844  Administration > 
Discovery 
Configuration 

Community string change detection is now case sensitive. 

QCCR1C18860 Scanner Generator Close All Windows on home page now prompts you if you 
are in the middle process of generating a Scanner. 

QCCR1C18866 Device Manager > 
Configuration Panel 

The device addresses are now sorted more efficiently. 

QCCR1C18898 Help > Database 
Schema > Base Sub-
Schema 

Database documentation now refers to “Discovery 
Configuration” instead of “Network Configuration.” 

QCCR1C18924  Aggregator The page context is preserved when going back and forth 
between Discovery Configuration pages located on the 
Aggregator and on the remote server(s). 

QCCR1C18942 Administration > 
System Configuration 
> Scanner deployment 

The “Clean up PDI data from workstations” option was 
removed since it was obsolete. 
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Number Location Description 

QCCR1C18945 Administration > Data 
Management > Agent 
download 

Internet Explorer no longer downloads a .tar.Z file and 
saves it as a .tar.tar file. 

QCCR1C18990 Server The restore window does not occasionally show up any more 
after a system reboot. 

QCCR1C19004 Administration > 
Discovery 
Configuration > 
Configuration Profiles 
> Agent Profiles 

The 3 drop-down menus (Agent deployment actions, Agent 
automatic upgrade schedule, and AUM agent migration) no 
longer return to their default values (if something else has 
been selected) after new credentials are added. 

QCCR1C19010 Administration > 
Discovery 
Configuration > 
Configuration Profiles 

Returning from an “Associated Device Group” in any of the 
Profiles screens now returns you to the proper tab and 
window.  

QCCR1C19011 Administration > 
Discovery 
Configuration > 
Device Groups 

Navigation between Device Groups and associated Profiles 
is now properly handled. 

QCCR1C19017 Documentation A help file has been added for the aggregate report 
inventory data transfer interval. 

QCCR1C19031  Server A race condition that seldom occurred when starting the 
Discovery database causing the System Monitor to abort 
has been eliminated. 

QCCR1C19036 Status > Device Status 
> Active devices 

The Modeling status no longer displays misleading 
information for scan only devices. 

QCCR1C19041 Server The device license limit for scanned devices is now reported 
consistently. 

QCCR1C19045 Status > Unrecognized 
files distribution 

Some minor UI issues with this screen have been resolved. 

QCCR1C19051 Documentation All obsolete information about the Alarms and Attribute 
Graph tabs has been removed from the “Service Analyzer” 
chapter in the Network Data Analysis Guide. 

QCCR1C19078  UI You can now log in using a browser that is configured with 
locales other than English without incurring an error since 
all non-English standard message files generated by 3rd 
party tools have been removed. 

QCCR1C19079  Virtual Devices For the VMware host, the Show Virtual Devices command 
is now disabled for devices already showing in the Virtual 
Devices window for that host. 
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Number Location Description 

QCCR1C19089 Administration > 
Discovery 
Configuration > 
Schedules 

Schedule names having exactly 256 characters are now 
properly handled. 

QCCR1C19094 Documentation An incorrect error message is no longer displayed in the 
online help when you attempt to delete a schedule that is 
associated with a profile. 

QCCR1C19116 Reports VirtualCenter reports are now sorted by VM Host device 
within a VirtualCenter device. 

QCCR1C19131 Health Panel “My User Alarms” command is now disabled when no 
selection is made in User Preferences. 

QCCR1C19145 Administration > 
Event Filter 
Configuration > 
Modify a filter 

The Java Script error: “state_transition_submit is not 
defined” no longer occurs when you submit the filter 
modification. 

QCCR1C19148 Administration > 
Discovery 
Configuration > 
Device Groups > 
Device Group Details  

Duplicate IP addresses imported from a file will now be 
ignored, rather than causing a data entry error. 

QCCR1C19150 Scanner Generator The output file name field is no longer pre-populated 
incorrectly. 

QCCR1C19157 Server If it is present, the integrity Cstats.PastRealtime table 
is checked (and repaired if necessary), thus preventing the 
database backup from failing. 

QCCR1C19168 Documentation A note has been added to the Installation and Initial Setup 
Guide and online help explaining that the communication 
port changes (if so configured) after Agent uninstall/install 
or Agent upgrade. 

QCCR1C19172 Server The DDM Inventory Server when checking if a scan file is 
available on a UNIX system no longer mistakenly raises an 
error when an agentless scan is in process but not 
completed. 

QCCR1C19184 Virtual Devices The Virtual Devices window no longer shows any port 
number when displaying the host title. 

QCCR1C19187 Reports The heading in the VLAN Inventory report for the default 
VLAN now displays correctly. 

QCCR1C19200 Reports The device manager link in the Network Documentation > 
Device Inventory By Virtual LAN report now opens the 
device manager for the correct device. 
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Number Location Description 

QCCR1C19204 Documentation A new section called “DDM Inventory Server and Automatic 
Configuration” has been added in the “Configuring the 
Discovery Process” chapter of the Installation and Initial 
Setup Guide explaining what is meant by automatic 
configuration and how the process occurs. 

QCCR1C19220 Aggregate Status > 
Aggregate server 
health 

The Last Connection check time is now updated. 

QCCR1C19233 Documentation The help file now lists all the possible reasons for device 
deactivation. 

QCCR1C19237 Server Network map database tables are now populated when the 
Scheduler starts so that the network map displays properly. 
This is visible only if the poll cycle is long enough; 
otherwise the problem is not noticed. 

QCCR1C19269 Server If invalid characters are detected in a scan file, the XML 
Enricher will not write these characters to the enriched 
scan (XML) file or the database import (TSV) file. 

QCCR1C19276 Server Those remote server properties that were reset by a restart 
of the Scheduler are no longer affected. 

QCCR1C19288 Device Manager > 
Diagnostics Panel 

When no entries are found on DNS lookup, a comprehensive 
error message is now displayed. 

QCCR1C19289 Server The backup is now performed once a day regardless of the 
circumstances. 

QCCR1C19314 Server Any partial backup is now deleted (if present) when the 
System Monitor starts. 

QCCR1C19317 Server Events are no longer generated after associated event 
filters have been deleted. 

QCCR1C19326 Web UI The Close command now closes online integrated help for 
the Device Manager, Port Manager, and other such applets. 

QCCR1C19333 Network Map Logic used by the Network Map has been improved thus 
preventing several map disconnect problems. 

QCCR1C19337 Discovery Engine The Discovery Engine will not restart if it is updating the 
Discovery Database while the database table optimization 
is occurring. 

QCCR1C19339 Help > Data Collected 
by Scanners 

The Data Collected by Scanners document no longer 
contains empty redundant headers from some database 
tables, such as hwSMBIOS. 

QCCR1C19357 Windows Scanner Serial numbers are now detected from all USB devices. 
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Number Location Description 

QCCR1C19394 Applet The default values in property applets (user defined 
defaults) are adjusted properly with the values imported by 
bulk data import. 

QCCR1C19397 Status > Device status 
> Device exceptions 

A column has been added to show the severity (alarm) of 
the item in question. 

QCCR1C19401 Linux Scanner The Linux Scanner no longer fails to detect when it is 
running inside a VMware virtual machine. This used to 
occur in some cases. 

QCCR1C19412 Administration > 
Discovery 
Configuration > 
Configuration Profiles 

The proper SNMP version 3 credentials are now deleted or 
updated when credential names are identical. 

QCCR1C19416 Administration > 
Discovery 
Configuration > 
Configuration Profiles 

The AUM Agent migration field is now properly replicated 
when an Agent profile is duplicated. 

QCCR1C19417 Administration > 
Discovery 
Configuration > 
Configuration Profiles 

Credentials no longer disappear after navigating to the 
Associated Groups tab and back (to the Settings tab) on the 
Mobile and Virtualization profiles pages. 

QCCR1C19419 System Panel The order of report time interval boundaries is now 
displayed correctly. 

QCCR1C19420 Server Database import no longer fails in some cases where 
directory names found in the scan files as part of the file 
and directory data are longer than 255 characters. 

QCCR1C19424 Scanner Generator The “Enable scanning of Java class files” option is no longer 
enabled as the initial default state. 

QCCR1C19430 Documentation All environments that cause the Scanner to exit (error level 
20) are now adequately described in the “Scanners” chapter 
in the Reference Guide. 

QCCR1C19436 Documentation The registry screen shot and explanation for extracting 
registry values in the Scanner Generator are now correct in 
the “Scanner Generator” chapter in the Configuration and 
Customization Guide. 

QCCR1C19439 Documentation The text rendering problem in the integrated online help no 
longer occurs. 

QCCR1C19444 Server A newly added user account will have the default password 
set to blank. 
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Number Location Description 

QCCR1C19452 Scanners The CPU serial number is now only detected for Intel CPUs 
supporting this feature preventing garbage output. Also, 
CPU serial number formatting is unified for UNIX and 
Windows. 

QCCR1C19455 Scanner Generator Zero is now a valid entry for “Only store files smaller than” 
option. 

QCCR1C19456 Scanner Generator When two Scanner Generators are running, they no longer 
interfere with each other when reading and writing 
persistent values locally. 

QCCR1C19468 Device Manager > 
Diagnostics Panel > 
Agent Ping 

The results of the “Agent Ping” action no longer display the 
Agent version for agentless devices. 

QCCR1C19474 Device Manager > 
Diagnostics Panel 

The results of Ping requests are now displayed using the 
proper locale character set. 

QCCR1C19476 Server On the Aggregator Server, the data transfer schedule now 
works correctly regardless of whether the schedule spans a 
day or more. 

QCCR1C19478 Server Auto identified device driver files are no longer added to the 
unrecognized file data in the database. 

QCCR1C19481 HP-UX Scanner The HP-UX Scanner no longer fails to detect the network 
card on HP-UX HPPA systems. This used to occur in some 
cases. 

QCCR1C19491 Server Active devices are no longer deleted first when room is 
needed in the Reports database. The deleted devices, then 
the deactivated devices, and then the active devices are 
deleted in that order until enough room is freed to 
accommodate the newly imported devices. 

QCCR1C19494 Find DNS queries now return multiple results where possible. 

QCCR1C19496 Server Restore no longer creates the <ROOT 
DIR>\scanners\Cert directory as a backup for the 
current server certificates before overwriting them in the 
<DATA DIR>\Cert directory with the ones found in the 
restore set. 

QCCR1C19501 Server Daylight Savings Time changes no longer affect scheduling 
of aggregator transfer jobs. 

QCCR1C19503 Reports During startup, database tables of zero length with a 
corrupt index file will now be repaired properly. 
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Number Location Description 

QCCR1C19504 Administration > 
Asset Questionnaire > 
Import answers 

Importing a large file no longer causes the UI to generate a 
proxy error. 

QCCR1C19507 Scanner Generator Mouse-over now always displays the description text on the 
hardware data page. 

QCCR1C19518 Server Merging of network and scanner models is fixed in cases 
when certain hardware fields contain special characters, 
such as the new line character. 

QCCR1C19542 Server The OPTIMIZE TABLE command has been replaced with 
the ALTER TABLE command, which performs the same 
function. Unlike the OPTIMIZE TABLE command, the 
ALTER TABLE command is non-destructive and eliminates 
table corruption that can occur from server crashes or other 
events. As a result, the user will no longer experience 
random corruption of database tables in the Aggregate 
database. 

QCCR1C19543 Server Backups and associated restores of large servers now work 
properly. 

QCCR1C19544 System Panel An error message is now displayed when there is a 
database-restore failure. 

QCCR1C19545 System Panel Time zones and Daylight Savings Time changes are now 
properly handled. 

QCCR1C19548 System Panel The progress bar position for the restore process is now 
properly displayed based on the actual progress. 

QCCR1C19554 Scanners The automatic asset field is no longer unconditionally 
converted to upper case. 

QCCR1C19560 UNIX Scanner Additional device node directories used in cluster 
environment have been filtered out. In particular, 
/global/.devices is excluded from scanning (in addition 
to the already excluded /dev and /devices). 

QCCR1C19581 XML Enricher Rules are now deleted from the user SAI file when 
applications using them are deleted. 

QCCR1C19586 Applet No Locate On Map buttons are visible when the Network 
Topology license is not present. 

QCCR1C19589 Server VMware discovery through VirtualCenter now collects data 
from the Server, Version, and Platform fields of the 
VMware hosts that VirtualCenter manages. 
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Number Location Description 

QCCR1C19590 Aggregate 
Administration > 
Remote server 
administration > 
Remote Server 
Properties 

Schedules are now properly displayed immediately after 
adding a new remote server. 

QCCR1C19593 Server The Discovery Engine no longer crashes when processing 
large UI requests, such as requests to retrieve values for a 
large number of device or port attributes. 

QCCR1C19595 XML Enricher Application type information is now set correctly when an 
application is created in the Auto SAI when the application 
rules are triggered. 

QCCR1C19598 Windows Scanner The logic that ignored known fake BIOS asset tags numbers 
has been enhanced to ignore additional known fake values, 
such as 000000000000000000. 

QCCR1C19599 SAI Editor The SAI Editor no longer crashes or displays an invalid 
collection index error when the Import from recognition 
result window is closed during the import process. 

QCCR1C19602 SAI Editor In the Options > SAI List dialog box, the Applications 
column is now replaced with the Version column, since the 
number of versions (not applications) is displayed in it. 
Also, the Options dialog has been made resizable so that 
you can see long directory names more easily; it now also 
remembers its size and position. 

QCCR1C19604 Web UI When Asset Questionnaire is selected as the home page and 
the “Highlight Row” option is set to “on,” mousing over the 
table in the Asset Questionnaire no longer produces the 
“object doesn't support this property or method” error 
message. 

QCCR1C19620 Aggregator Finding the remaining disk space and halting the transfer 
of jobs on an Aggregator if not enough space is left on the 
disk now works properly, regardless of the operating system 
(including Windows Server 2008). 

QCCR1C19655 Agent An issue where, in certain circumstances, it was possible for 
a remote user to gain unauthorized access to DDM 
Inventory Agents no longer occurs. More details are 
available in the HP Security Bulletin 
HPSBMA0243SSRT090084 or in CVE-2009-1419. 

QCCR1C19656 Server The length of the Server Certificate RSA key used to 
communicate with the Agent is now set to 2048 as 
documented. 
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QCCR1C19657 Documentation A cautionary note has been added to the “Configuring the 
Discovery Process” chapter in the Installation and Initial 
Setup Guide about the possibility of exceeding the 2000 
device range limitation if wildcards are used when defining 
device groups using an IP address or range. 

QCCR1C19659 Server Default filters are no longer restored if no filters are found. 
As a result, you can now delete all filters if so desired. 

QCCR1C19661 Solaris SPARC 
Scanner 

Detection of new UltraSPARC CPUs has been improved. 

QCCR1C19663 Reports The grouping of records is now accurately displayed by 
performing case insensitive character comparisons of the 
keys which determine report groupings. 

QCCR1C19730 Linux Agent Random Agent freeze no longer occurs on Linux systems. 

QCCR1C19731 Server The race condition when trying to communicate with a 
device through multiple modes no longer occurs. 

QCCR1C19733 Server The DDM Inventory Server no longer outputs debug level 
log messages into the discovery log file when installed on a 
server with Turkish regional settings. 

QCCR1C19739 Server Temporary swap table 
Aggregate.SwapASttributeGroupStateSummaryTmp is 
no longer left behind once the process it supports has been 
executed. 

QCCR1C19741 Reports The Virtual Devices>VirtualCenter reports no longer show 
duplicate VirtualCenter devices. 

QCCR1C19743 Server Credential errors reported when performing an agentless 
scan on Windows systems using accounts that do no have 
enough privileges no longer occur. 

QCCR1C20362 Scanners When a scanner is identifying a Solaris ELF executable, it 
no longer outputs a debug “Safety check” error message in 
the scanner log. 

QCCR1C20369 Documentation A note has been added to the “Upgrade and Migration 
Scenarios” chapter of the Installation and Initial Setup 
Guide explaining that you must clear the browser cache on 
machines that are used to access the DDM Inventory Web 
UI. 

QCCR1C20370 Server On an Aggregator, the Appliance table is no longer 
regularly locked by the Check Connection process to avoid 
freezing the Aggregate database refresh processes when a 
long user query is concurrently running. 
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QCCR1C20371 Agentless Scanning The agentless scan for Windows 2008 no longer raises a 
security alert about the service requesting UI access. 

QCCR1C20372 Reports In the Network Documentation > Device Inventory by 
UNSPSC reports, the counts on the pie chart in this report 
are no longer greater than the actual counts if there are 
inactive devices. 

QCCR1C20373 Reports In the Network Documentation > Device Inventory by 
UNSPSC reports, pie chart data is now refreshed whenever 
the refresh link in the summary table report is pressed. 
This ensures that the data in the pie chart is always in sync 
with the data in the summary table. 

QCCR1C20377 Reports In the Device Inventory by UNSPSC reports, the counts in 
the summary report and drill-downs reports no longer differ 
occasionally. 

QCCR1C20414 Server Windows Remote Procedure Call (winrpc) agentless 
scanning now works correctly when a hard-coded path 
containing backslash symbols is used in the credentials 
configuration. 

QCCR1C20421 UNIX Scanner Software scanning on some systems with directories 
containing a large number of non-regular files (for example, 
sockets) no longer causes the Scanner to crash because of 
stack overflow. 

QCCR1C20425 Scanner Generator When defining a sequence asset field in the Scanner 
Generator, the default value for “ignore strings shorter 
than” is now one instead of zero. 

QCCR1C20429 Windows Scanner Extra protection has been added to the Scanner to avoid a 
crash during detection of Advanced SCSI Programming 
Interface (ASPI) devices. 

QCCR1C20453 Server The Discovery Engine no longer crashes when a device 
record is simultaneously accessed by more than one user, 
where one user has purged the device record and another 
user continues to work with the same device record. 

QCCR1C21113 Server VMware discovery no longer fails with a “WebService error” 
exception. 

QCCR1C29251 Scanner Generator WMI extract no longer reverts the “Collect all instances” 
parameter in Scanner Generator. 

QCCR1C29286 Documentation The incorrect note in the Planning Guide that was applied 
to the ODBC connector port indicating that it referred to 
VMware discovery only has been removed. 
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QCCR1C29456 Server Files older than 7 days are now removed from the 
<DataDir>\Scans\failed\Delta directory. 
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Known Problems, Limitations, and Workarounds  

Agents 

 When you install the Agent on Windows Vista machines using an account other than the 
"Administrator" account, the firewall exception is not added into the exceptions list (QCCR1C382).  

 On Mac OS X 10.4.10 and above, there may be a problem with contacting the Agent because it can be 
blocked by a firewall. The Agent port needs to be enabled manually either via System Preferences > 
Sharing > Firewall or via the XServe administration tool in case of centralized administration 
(QCCR1C674). 

 The utilization plug-in (not the main agent) may not function correctly if installed on a new Windows 
machine. Errors in the plug-in log will indicate an error connecting to the registry (QCCR1C29392). 

Agentless 

 In the agentless log file, the first line of the log indicates that there was an error removing the 
ovedscansvc.exe file. This is just a warning message and does not mean there is necessarily an error 
(QCCR1C19019). 

 When using agentless scanning, once SSH credentials have been successfully used to scan a device and 
they are still configured to be used and valid, the credentials cannot be changed (QCCR1C19038). 

Scanners 

 Automounts are being scanned in HP-UX and Linux systems (QCCR1C1163).  

 In the Scanner Generator if a previously generated file is used to populate the Scanner Generator 
options and software scanning is disabled, the Scanner will still attempt to store any previously 
configured custom stored files (QCCR1C19042). 

 Scanners may fail if the scanner log file is extremely large in size (QCCR1C20445). 

Analysis Workbench 

 In File > Load Options > Asset Fields > Add > Text File Extract > Options, whenever the “Treat field as 
a File Name’’ option is selected, the “Replace invalid characters with’’ field must be populated as well, 
even if the “Delete invalid characters’’ option is selected instead.  Otherwise, the “The file ‘Replace 
invalid characters with’ may not be empty” error dialog appears (QCCR1C1275). 

 For files in the root directory, the leading slash is missing from the beginning of the UNIX directory 
structure in AW (QCCR1C1480). 

 The Analysis Workbench sample script does not run on Windows 2008 because the default directories 
are not set correctly. The script works properly on all other supported platforms (QCCR1C19475). 

Server Installation 

 After an uninstall, the branding registry keys are left over (QCCR1C1434).  
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 Non-ASCII characters used in data directory path name can cause problems during the installation 
(QCCR1C16520 and QCCR1C1472). 

 When uninstalling DDM Inventory on a small server, the uninstaller may not be able to stop the 
database. It may take several tries to uninstall the software (QCCR1C2405). 

 DDM Inventory with a Network Topology license should not be installed on VMware (QCCR1C5271). 

 The SNMP extension registry key may not be removed on some Windows 2008 server installations 
(QCCR1C29306). 

Server 

 In some cases, the ID assigned to the auto.zsai and the user.zsai files may be the same. This 
results in the inability to load both files into the client tools at the same time (QCCR1C4448). 

 An older OpenSSL DLLs in the system PATH can affect the DDM Inventory Apache server and Perl 
engines (QCCR1C5447). 

 If your server has another service using port 80, the HP Discovery Apache service will not run properly. 
As a workaround, you can comment out the “Listen 80’’ directive in the httpdf.conf file 
(QCCR1C6670). 

 If there is a MySQL query that takes too long, DDM Inventory will not function properly and you may 
need to restart System Monitor to recover (QCCR1C7409). 

 In some cases, purged devices may appear in the modeling queue despite already having been purged 
(QCCR1C19165). 

 VMware discovery may, in some cases, use an incorrect IP address if the VMware image has been 
recently powered off (QCCR1C19379). 

 Firefox 3.x page navigation may appear incorrect in some cases (QCCR1C19250). 

 Running JRE 1.5 and Firefox 3.x on Vista or Windows Server 2008 machines may cause the applets and 
the browser to close (QCCR1C19437). 

 Sometimes when logging into the DDM Inventory server, a pop-up window opens with the message 
“Jscript compilation error: Expected ‘}’”.  This problem occurs as a result of calling Java Applets from 
Internet Explorer (this issue does not seem to occur with Firefox). The problem is not specific to DDM 
Inventory and can be seen on various Web pages where Applets are present. Note that the pop-up 
window opens with this message only if the “Disable script debugging” option is disabled. Otherwise, if 
this option is enabled, only a warning icon (yellow triangle containing an exclamation mark) will appear 
on the left-side of the Internet Explorer taskbar when this problem occurs. As determined so far, this 
problem does not occur if you are running JRE 1.4 or earlier. This problem has occurred on both Internet 
Explorer version 6 and version 7 (QCCR1C19591). 

 If a DDM Inventory service is interrupted while in the starting phase, the system monitor service may 
not successfully be able to start (QCCR1C20408). 

 If a non administrative user logs into the Windows server, an error indicating that the syspanel.log 
file cannot be created may occur (QCCR1C20437). 

 The XML Enricher may report error 103 indicating that there is an issue with processing 
(QCCR1C20555). 

 The hwOscontainerProperties table is not verified on startup by the startup sequence 
(QCCR1C29336). 

 If agent and agentless scanning is enabled for a property group, in some cases installing and then 
uninstalling an agent may result in DDM Inventory not recognizing that a device has an agent on it 
(QCCR1C29364). 
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System Panel 

 When there are multiple instances of the DDM Inventory System Panel running on the Server, only one 
of the System Panel instances will display Port Usage information (QCCR1C20409). 

Web User Interface 

 After an agentless scan (using SSH) has successfully been run, the account used for this connection 
cannot be changed unless you delete the account from the DDM Inventory UI (QCCR1C19398). 

Applets 

 In some cases it is possible to add a new publisher or version that already exists in the User SAI files 
(QCCR1C29303). 

 The Express Teaching applet may allow the user to teach an application even though it is set to disabled 
in the UI.  The items taught will not be added to the SAI file (QCCR1C29369). 

Administration 

 Depending on the licenses, the “Resource/ Environment manage’’ option in Discovery Configuration may 
not have any effect (QCCR1C7034). 

 In the Service Analyzer, device breaks may show up in the filter list for line breaks (QCCR1C18988). 

 If a VirtualCenter server does not respond to a request, DDM Inventory will not report an error 
(QCCR1C19059). 

 In some situations, the Agent ping button in Device Manager may not ping a device. The agent ping may 
not function until the next time the scanner workflow runs (QCCR1C19063). 

 When VMware discovery is run on a VirtualCentre device, the VMware images on it may appear in the 
inventory even if the IP addresses are not in the IP ranges to be discovered (QCCR1C29277). 

Web Asset Questionnaire 

 In Internet Explorer, when connecting to the main page through a proxy server, the “You are connecting 
from’’ IP address reported will be the IP address of the proxy server not that of the remote computer 
address (QCCR1C764). 

 The UI may show non-printable characters in text fields (QCCR1C2408). 

Reports 

 The + symbol in the Navigation Tree next to reports is missing. This does not affect functionality 
(QCCR1C18894). 

 When using HP Client Automation Enterprise Reporting Server, some new CPU type may not be 
displayed correctly (QCCR1C19380). 

 The Alarm summary of Collisions, Frame Relay FECN/BECN,DE Inventory reports and Device Load 
Average may report N\A instead of the correct values (QCCR1C29312). 
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Licensing 

Alarms License  

 Alarms-related items are not always hidden (QCCR1C5673). 

Internationalization 

 Various UI screens (reports, status reports, Device Manager, and so on) format the “day of the month’’ 
part of the date as Arabic numerals instead of using the language option configured by the operating 
system (QCCR1C416). 

 When non-ASCII characters are used to define Schedules in the Discovery Configuration, the Status > 
Current Settings > Discovery Configuration may display errors when listing the Configuration Profile 
information (QCCR1C490). 

 There are several problems with the SAI Editor accepting characters in the Korean code page 
(QCCR1C507, QCCR1C508). 

 The statistics graphs do not use the language options configured in the operation system and will always 
format the dates in English (QCCR1C2043). 

 SAI files with Chinese names may appear incorrect when viewing them with the DDM Inventory web 
user interface (QCCR1C19372). 

 If the name of a User zSAI file contains Chinese characters, the XML Enricher may not be able to load 
that zSAI file (QCCR1C19402). 

 Recognition rules written in Chinese may not recognize all versions (QCCR1C19610). 

 Some locales may not report the total disk space correctly in some cases (QCCR1C19614). 
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